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FCC Part 15 Class B 

This device complies with Part 15 of the FCC Rules.  Operation is subject to the following two conditions:  (1) 
this device may not cause harmful interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation. 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC rules.  These limits are designed to provide reasonable protection against harmful 
interference in a residential installation.  This equipment generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications.  However, there is no guarantee that interference will not occur in a particular installation.  If 
this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try too correct the interference by one or more of the 
following measures: 

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and the receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

This equipment complies with Canadian and FCC radiation exposure limits set forth for an uncontrolled 
environment.  This equipment is in direct contact with the body of the user under normal operating conditions.  
This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter. 

Part 15.21  Caution: Changes or modifications not expressly approved by Printek, Inc. could void the user’s 
authority to operate the equipment. 

Bluetooth Equipped Models: 
For units equipped with an OEM Serial Port Adapter from connectBlue, reference FCC ID: PVH070101.  For 
units equipped with a Printek, Inc. Bluetooth module, reference FCC ID: B9J-0213900444. 

Wi-Fi Equipped Models: 
This equipment contains an OEM Wireless LAN Node Module from DPAC Technologies with FCC ID: 
RTTABDB-SEDP.  This device has shown compliance with the conducted emissions limits in 15.107, 15.207, 
or 18.307 adopted under FCC 02-157 (ET Docket 98-80). 

 
Battery Disposal 

Only dispose of used batteries according to your local regulations.  If you do not know your local 
regulations, the Rechargeable Battery Recycling Corporation (RBRC) is a non-profit organization 
created to promote recycling of rechargeable batteries.  For more information visit www.rbrc.org. 
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This manual is based on printer firmware version 3.2.  Specifications are subject to change without notice. 
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 Read all setup and operating instructions before proceeding with operation. 

Do not operate in an enclosure unless properly ventilated.  Make sure no ventilation openings are blocked or 
obstructed, which may result in the printer overheating. 

Do not operate near a heat source. 

 

 Lesen Sie vor der Inbetriebnahme die Aufbau- und Bedienungsanleitung. 

Betreiben Sie den Drucker nicht in einem kleinen, geschlossenen Raum, es sei denn dieser wird ordnungsgemäß 
belüftet. Achten Sie darauf, dass die Lüftungen nicht blockiert oder versperrt sind, denn dies kann zum 
Überhitzen des Druckers führen. 

Nehmen Sie den Drucker nicht in der Nähe einer Wärmequelle in Betrieb. 

 

 

 
No user-serviceable parts inside.  Refer service or repairs to a qualified service 
professional. 

Use of genuine Printek replacement parts is required to warrant proper, safe operation.  

Any alteration or modification of this device voids the user warranty and may make the product unsafe to 
operate. 

The print head and motors get hot during use.  Wait until they cool before touching them. 

Make certain the printer is disconnected from AC power before removing any covers or performing any 
required cleaning or maintenance. 

Connecting this printer to an ungrounded receptacle can result in electrical shock. 

Never place the printer near inflammable or explosive substances.  Do not operate near liquid or spill liquid into 
the printer at any time. 

 

 
Enthält keine Teile, die vom Bediener instandgesetzt werden können. Bitte wenden Sie sich bei 
Instandsetzung oder Reparatur an qualifiziertes Kundendienstpersonal. 

Die Verwendung von echten Printek Ersatzteilen ist notwendig, um ordnungsgemäßen, sicheren Betrieb zu 
gewährleisten.  

Änderungen oder Modifikationen dieses Geräts machen die Garantie ungültig und können den sicheren Betrieb 
des Produkts gefährden. 

Während des Druckens werden Druckerkopf und Motoren heiß. Warten Sie, bis sich die Teile abgekühlt haben, 
bevor Sie sie berühren. 

Vergewissern Sie sich, dass der Drucker nicht mehr an die Stromquelle angeschlossen ist, bevor Sie 
Abdeckungen abnehmen oder das Gerät reinigen bzw. warten. 

Schließen Sie diesen Drucker nicht an eine ungeerdete Steckdose an; dies kann zum Elektroschock führen. 

Setzen Sie den Drucker niemals in die Nähe von feuer- oder explosionsgefährlichen Stoffen. Betreiben Sie den 
Drucker nicht in der Nähe von Flüssigkeiten und lassen Sie keine Flüssigkeiten in den Drucker gelangen. 
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Introduction 

Thank you for purchasing a Printek FieldPro RT43 Series mobile thermal printer.  The FieldPro series offers a 
variety of configurations to suit any printing environment. 

The RT43 prints on receipt paper supplied in roll form up to 4.125 inches wide and includes “black mark” 
sensing capabilities on the printed side of the media.  All models are equipped with a “Universal Port” which 
supports cabled, serial communications using an optional RS-232C or USB cable.  All models also support an 
optional internal Bluetooth or Wi-Fi interface. 

Each printer is shipped with a battery, a carrying strap, a Quick Start Guide, and one roll of receipt paper. 

This manual has been written for systems administrators and end users and contains information needed for the 
set up and everyday use of the printer.  It also contains information regarding preventative maintenance and 
how to obtain service if needed. 

The information in this manual is arranged in the following sections: 

Getting Started contains the minimum steps required to get the printer set up and able to communicate with 
your host system. 

Daily Operation describes additional activities that are likely to be encountered under normal operation. 

Printer Configuration contains detailed information on all the features available in the Setup menus. 

Interfacing To A Host Computer provides basic information related to connecting the printer to a computer via 
a cabled serial connection or the optional Bluetooth or Wi-Fi interfaces. 

Power Considerations provides information regarding operation on the internal battery or from an external 
supply. 

Maintenance and Troubleshooting contains information on how to care for your printer to keep it working at 
peak performance.  This section also includes a list of printer error conditions and suggestions on how to solve 
problems. 

Print & Font Samples offers examples of printed output and character mapping for standard fonts. 

Specifications provides detailed information regarding performance, media specifications, and options available 
for your FieldPro series printer. 

Glossary of Terms is a reference for terminology used within this manual and in the computer and printer 
industry. 
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Getting Started 

 

Printer Features 

 

Before preparing your new FieldPro RT43 for use, please refer to Figure 1 and familiarize yourself with the 
locations of the various features of the printer. 

 

 

 

Paper Door 

Tear Bar
Paper Door

Release Lever 

Battery

Control Panel 
Carrying Strap 

Power Connector
Universal Port Cover 

Right Side 
Of Printer 

Figure 1 - Printer Features 

 

 

Battery Installation and Charging 

The battery for your FieldPro printer is shipped in an “uncharged” state.  The battery must be charged using the 
following instructions prior to using the printer for the first time.  Maximum battery capacity is not reached 
until after completing a minimum of three complete charge and discharge cycles. 

Please refer to Figure 2.  Install the battery by first placing the end of the battery where the battery contacts are 
located into the printer, and then press down on the end where the release lever is located until the lever “snaps” 
into place. 
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Getting Started 

 

 

 

Figure 2 - Battery Installation 

Release Lever

Battery Contacts

 

To charge the battery, connect an optional power supply to the appropriate input source, and then connect the 
output of the power supply to the printer’s Power Connector at the location shown in Figure 3.  The Battery 
Indicator will turn on and remain on until the battery is fully charged.  This may take up to 2½ hours. 

 Note: You must charge the battery for at least 2½ hours prior to the first use. 

 Caution: Use only Printek power supplies designed specifically for your FieldPro printer.  Using a different 
power supply may cause damage to the printer and will not be covered by the printer’s warranty.  
Printek power supplies are available for use with 100-240VAC/50-60Hz and for12/24VDC vehicle 
applications. 

 

 

 Power Connector
Battery Indicator

Figure 3 - Power Connector & Battery Indicator 
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Getting Started 

Installing Media 

 

Each printer comes supplied with a roll of receipt paper.   

 Note: For maximum performance and optimum print quality, use only genuine Printek media in your 
FieldPro printer.   

To install media, you must release the paper door by moving the Paper Door Release Lever in the direction 
shown in Figure 4 and then lift the paper door to expose the paper compartment.  

 

 

 
 

Paper Door
Release Lever

Figure 4 - Opening Paper Door 

 

Unroll a small portion of the paper as shown, place the roll into the printer, and close the Paper Door.  If the 
printer is turned on, you may now press the Paper Feed Button to advance the paper and then tear it off in 
preparation for printing. 

 Note: If you need to use a paper width other than what was supplied with your printer, please refer to 
Media Specifications in the Specifications section of this manual. 
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Getting Started 

Turning the Printer On and Off 

 

Refer to Figure 5 and locate the printer’s Power Button.  To turn the printer on, simply press and release the 
Power Button.  To turn the printer off, press and hold the Power Button.  The printer will “beep” and then 
power down after the button is released. 

 

 

 
 Power 

Indicator
Power 
Button 

Paper Feed 
Button

Error 
Indicator

Battery 
Indicator

Figure 5 - Printer Control Panel 

 

 

 

Performing A Printer Self Test 

To perform a self test, press and hold the Paper Feed Button while turning on the printer with the Power Button.  
The printer will print a test page with the following information:  

• The printer’s firmware revision level and release date. 
• Printer serial number. 
• The current values for items in the Format menu. 
• The current values for items in the Options menu. 
• The type of optional interface, if installed, and which interface is currently selected. 
• The presence of the optional Magnetic Card Reader, if installed. 
• The current battery voltage. 
• A list of additional fonts, if installed. 
• A list of logos, if installed. 
• A print head test pattern. 

 

 

 Note: At the bottom of the test page the message “Press Feed For Setup Menu” will be printed.  Do not 
press any buttons at this time.  After approximately four seconds, “Setup Not Requested” will be 
printed and the printer is ready for normal use. 
 

The internal setup menus allow changes to be made to the printer’s interface and printing features.  
Improper changes may make your printer perform poorly or not at all.  These menus should only be 
used under the direction of your technical support staff.  For more information, please refer to the 
Printer Configuration section on page 13 of this manual.  
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Getting Started 

Removing Printer Output 

To tear the paper, pull the paper against the tear bar (a sharp edge on the paper door) at a slight angle as shown 
in Figure 6, and then continue to pull the paper in the direction shown to tear it off. 

If all the printing is not yet out of the printer and the host has finished sending data to the printer, the paper may 
be positioned for tearing by simply pressing the Paper Feed Button. 

 

 

Figure 6 - Tearing Off Printer Output 

 

Host Interface Set Up 

Prior to using your printer with a computer application, the printer’s interface settings must match those 
required by your host system. 

Each printer is equipped with a Serial interface which may be used as either RS-232C or USB depending on 
which optional cable is attached to the printer.  Additionally, the printer may also be equipped with either a 
Bluetooth interface or Wi-Fi interface.  The model description on the serial number label will indicate if one of 
the optional interfaces is installed.  The factory defaults for the basic settings for each interface are listed below. 

 
        Interface        Factory Default Interface Settings                                                          
 Serial Printek Emulation, 57,600 Baud, 8 Data Bits, 1 Stop Bit, No Parity,  

RTS/CTS Handshaking 
 Bluetooth Printek Emulation, Pairing Mode = Paired, Security Disabled, PIN = “0”, 

Bluetooth Name = “FP-SerialNumber”. 
 Wi-Fi Printek Emulation, Connect to any SSID, Infrastructure, WEP = None,  

DHCP enabled, TCP tunnel port 8023, Channel = 1,  
DHCP Name = “FP-SerialNumber”. 

If the above settings do not sufficiently match your host system requirements, please refer to the Printer 
Configuration and the Interfacing To A Host Computer sections of this manual. 
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Getting Started 

Using The Carrying Strap 

 

The printer’s flexible carrying strap with multiple hook-and-loop fasteners is designed to be used in a variety of 
ways to carry or mount the printer.  The most common use will be to hang the printer from a belt or from the 
optional shoulder strap as shown in Figure 7.  To use the strap in this way, simply pull the end of the strap from 
the bottom of the printer, route it around the back side of your belt and fasten the strap back on itself as shown. 
You may also use this method with the Shoulder Strap or keep the Carrying Strap in its original position. 

 

 

 

 

Belt 

Shoulder 
Strap 

Figure 7 - Carrying Strap on Belt or Shoulder Strap 
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Daily Operation 

 

Introduction 

For normal daily use, most users will only need to turn the printer on and off, tear off printed output, load paper, 
and charge the battery as described in the Getting Started section of this manual.  This section of the manual 
provides additional detail regarding the printer’s control panel and for recharging the battery.  Use of the 
optional Magnetic Card Reader is also described. 

 

 

 

Control Panel 

The FieldPro series printers are designed for simple operation with an easy to use control panel.  As shown in 
Figure 8, the control panel consists of three indicators and two pushbuttons.  An audible tone is also used to 
indicate button presses and certain error conditions. 

 

 

 
 

 
Power 

Indicator
Power 
Button 

Paper Feed 
Button

Error 
Indicator

Battery 
Indicator

Figure 8 - Control Panel 

 

The purpose and functionality of all of the buttons and indicators are described in Figure 9.   
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Daily Operation 

 

Symbol Function Status 

 
Power Button Used to turn the printer on or off.   

 
Paper Feed Button Advances paper a preset distance or to the next black 

mark.  Also used to clear paper error conditions.   

Printer is Off. 

Printer is On. 

 
Printer is in Standby.  (Will wake on 
receipt of data.) 

Power Indicator 

 
Printer is receiving data and/or printing, or 
is in the Control Panel Setup mode. 

Battery is fully charged. 

or Battery needs to be charged. 
 

Battery Indicator 

 
Battery is being charged. 

No error. 

With Alarm
 

Paper out.  (Load paper and press Paper 
Feed to clear.)

Paper Door is open.    
Error Indicator 

With Alarm
 

Communications error.  (Power off to 
clear.) 

 = On = Off = Slow Blink = Rapid Flash
 

Figure 9 - Control Panel Buttons & Indicators 
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Daily Operation 

 

Battery Charging 

The FieldPro RT43 contains battery monitoring and charging circuitry so that the battery may be charged while 
in the printer.  Charging the battery in the printer requires an optional power supply.  Printek offers power 
supplies for use with 100-240VAC/50-60Hz and 12/24VDC for vehicle applications.   

The printer’s Battery Indicator flashes whenever the battery needs recharging.   

To charge the battery, connect the power supply to the appropriate source, and connect the output of the supply 
to the printer’s power connector shown in Figure 10.   

Caution: Use only Printek power supplies to power your printer and charge batteries.  Other power supplies 
may damage the electronics and printing mechanism.  Damage caused by use of a non-Printek power 
supply will not be covered by the printer’s warranty. 

 

 

 Power Connector
Battery Indicator 

Figure 10 - Power Connector & Battery Indicator 

 

When the power supply is connected, the printer’s charging circuitry will determine if the battery currently 
requires charging and if so, will turn on the Battery Indicator until the battery has reached sufficient charge.  
Depending on the condition of the battery, charging may take up to 2½ hours to complete.  When fully charged, 
the Battery Indicator will turn off. 

Leaving the power supply connected to the printer will cause the printer to continuously monitor the condition 
of the battery and keep the battery charged. 

For more information regarding battery charging, battery life, and battery disposal, refer to “Battery Care” on 
page 34. 
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Daily Operation 

 

Using the Magnetic Card Reader 

The optional Magnetic Card Reader (MCR) may be used by some applications to read information from credit 
cards, drivers licenses, etc. 

When the host system sends a request to the printer to enable the Magnetic Card Reader, the MCR Indicator 
will light to indicate that the card may now be passed through the MCR slot, or “swiped”.  Refer to Figure 11 
for the card orientation. 

 

 

 
 

MCR Indicator

Figure 11 - Using The Magnetic Card Reader 

 

If the card is read successfully, a short beep will sound and the MCR Indicator will turn off to indicate success 
as the data is sent to the host system.   

If the card is not read successfully, a longer error tone will sound, the Error Indicator will light momentarily and 
the reader will be re-enabled to allow the card to be swiped again to attempt a successful read.   

The length of time allowed before the timeout occurs is specified by the host application program.  Once a 
timeout occurs, the Error Indicator will turn on momentarily and the reader will be disabled. 
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Printer Configuration 

Introduction 

This section describes printer operating features that may be configured to allow FieldPro series printers to 
communicate and operate with your computer and applications.  These features are grouped into logical 
groupings as “menus”.   

Two methods are available to change the configuration features of the printer.  The preferred method is to use 
the Printek Mobile Setup Utility, a Windows® based program which may be downloaded from a Printek web 
site.  The other is to use the built in Control Panel Setup which is described on page 25.  Depending on what 
feature needs to be changed, you may need to use either one, or both, of these methods. 

The tables below list the features available in each setup menu.  Which setup method may be used to change the 
values of these features is indicated by a checkmark.  Items marked with an asterisk (*) for one of the setup 
methods will have some restrictions on the values that may be set using that method.  Following the tables are 
detailed descriptions of each setup feature. 

 

 

Setup Menu Summary 

INTERFACE MENU – All Interfaces 

Modify From 
Menu Item Values Default Value Control 

Panel 
Setup 
Utility 

Switch to Serial Interface Press Power to switch. n/a   
Switch to Bluetooth Interface 
(If installed) 

Press Power to switch. n/a   

Switch to Wi-Fi Interface  
(if installed) 

Press Power to switch. n/a   

Print Interface Settings n/a n/a   
 

INTERFACE MENU – Serial Selected 

Modify From 
Menu Item Values Default Value Control 

Panel 
Setup 
Utility 

Emulation Printek, O’Neil, ZPL-II, Mt3, CPCL Printek   
Baud Rate 9600, 19200, 38400, 57600 57600   
Data Bits 7, 8 8   
Stop Bits 1, 2 1   
Parity None, Even, Odd None   
XON/XOFF On, Off Off   
ETX/ACK On, Off Off   
RTS/CTS On, Off On   
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Printer Configuration 

INTERFACE MENU – Bluetooth Selected  

Modify From 
Menu Item Values Default Value Control 

Panel 
Setup 
Utility 

Emulation Printek, O’Neil, ZPL-II, Mt3, CPCL Printek   
Paired Mode Paired, Unpaired Paired   
Role Policy Defer, Master Defer   
Discoverability On, Off On   
Pin Up to 16 Numeric Characters 0   
Security On, Off Off   
Local Name Up to 16 Alphanumeric Characters FP-Serial #   
 

INTERFACE MENU – Wi-Fi Selected 

Modify From 
Menu Item Values Default Value Control 

Panel 
Setup 
Utility 

Emulation Printek, O’Neil, ZPL-II, Mt3, CPCL Printek   
WLAN Type Peer-to-Peer, Infrastructure Infrastructure *  
WLAN Channel 1 to 14 1   
WLAN SSID  any   
WLAN WEP Bits 0, 64, 128 0   
WEP Key 1-4 10 or 26 Char. Hex String (Blank)   
WLAN Auth Auto, Open, Shared Auto   
IP Address Assign DHCP, Static DHCP   
IP Address  0.0.0.0   
IP Subnet Mask  0.0.0.0   
IP Gateway  0.0.0.0   
Tunnel Port  8023   
 

FORMAT MENU 

Modify From 
Menu Item Values Default Value Control 

Panel 
Setup 
Utility 

Font SansSerifA at 4.2, 5.5, 10.2, 10.7, 
18.5, 20.3 cpi;  Courier at 12.7, 
13.5, 14.5, 15.6, 16.9, 18.5, 20.3, 
22.6, 25.4, 34.0 cpi; or Downloaded 
fonts if present. 

16.9 Courier   

Spacing 0 to 10 Dot Rows 3   
Left Margin 0 to 1.0244” 0   
Right Margin 0 to 1.0244” 0   
Print Contrast -35% to 35% 0%   
Max Paper Speed 0.32, 1.36, 1.92, 2.35, 2.72, 2.81 ips 2.81 ips   
FFeed Distance 0 to 2.5216”, Mark Sensing 1.26”   
Mark Sensitivity -10 to +10 0   
Tearbar Adjust -0.295 to 0.315” 0.000”   
Top of Form Adjust -0.295 to 0.295” 0.000”   
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Printer Configuration 

PRINT ALL LOGOS IN MEMORY 

Modify From 
Menu Item Values Default Value Control 

Panel 
Setup 
Utility 

Print All Logos in Memory n/a n/a *  
 

OPTIONS MENU 

Modify From 
Menu Item Values Default Value Control 

Panel 
Setup 
Utility 

Left Paper Guide Adjust A – G A   
Right Paper Guide Adjust None, 1 – 9 None   
Auto Power Down Off, 1 – 15 Minutes Off   
Print Promo Off, On Off   
Print Header Off, On Off   
     
     
     
 

HARDWARE MENU 

Modify From 
Menu Item Values Default Value Control 

Panel 
Setup 
Utility 

Enter Hex Dump Mode Off, On Off   
Burnin Mode Off, On Off   
Reset to Factory Defaults Hold Power 10 Sec. n/a   
 

 

 

 

 

Interface Menu 

The Interface Menu is actually a series of menus.  These menus are used to match the printer to the host system 
or device that will be used to send and/or receive data to/from the printer.  Which Interface Menu affects the 
printer is dependent upon whether an optional Bluetooth or Wi-Fi interface is installed, and if so, which 
interface is currently selected as the active interface.  Switching the active interface from one interface to the 
other is only available through Control Panel Setup and is described on page 25.  The menu features for the 
Serial, Bluetooth, and Wi-Fi interfaces are described below. 

 Note: When using Control Panel Setup, you may select “Print Interface Settings” to obtain all the features 
and their values for the currently selected interface. 
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Printer Configuration 

Serial Interface 
The following Serial Interface Menu features are only available and/or only take affect when the Serial Interface 
is currently selected as the active interface.  For information on how to select the active interface, please refer to 
Control Panel Setup on page 25.   

 Note: Factory default values are indicated by an asterisk (*). 

 

Emulation 

Possible Values:  Printek*, O’Neil, ZPL-II, Mt3, CPCL 

This feature sets the family of printer commands that may be used by a host application program to control the 
various capabilities of the printer.  The printer will only respond to commands valid for the currently selected 
emulation.  For more information, please refer to the MtP Series & FieldPro Programmer’s Manual. 

 

Baud Rate 

Possible Values:  9600, 19200, 38400, 57600* 

This feature sets the baud rate for the Serial interface.  The value must match the setting used on the host 
system. 

 

Data Bits 

Possible Values:  7, 8* 

This feature sets the number of data bits in the serial character frame.  The value must match the setting used on 
the host system. 

 

Stop Bits 

Possible Values:  1*, 2 

This feature sets the number of stop bits included in the serial character frame.  The value must match the 
setting used on the host system. 

 

Parity 

Possible Values:  None*, Even, Odd 

This feature sets the parity checking requirements for the data bits in the serial character frame.  The value must 
match the setting used on the host system. 

 

XON/XOFF Handshaking 

Possible Values:  Off*, On 

This feature enables or disables the XON/XOFF (DC1/DC3) character handshaking method used to control data 
flow from the host system to the printer.  When enabled, an XOFF character will be sent by the printer 
whenever the printer’s input buffer is nearly full.  An XON character will be sent whenever the printer’s input 
buffer becomes nearly empty. 
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Printer Configuration 

ETX/ACK Handshaking 

Possible Values:  Off*, On 

This feature enables or disables the ETX/ACK character handshaking method used to control data flow from the 
host system to the printer.  When enabled, an ACK character will be sent by the printer after an ETX character 
has been received and processed out of the input buffer.  ETX characters used for handshaking cannot be part of 
an escape sequence. 

 

RTS/CTS Handshaking 

Possible Values:  Off, On* 

This feature enables or disables the RTS/CTS hardware handshaking method used to control data flow from the 
host system to the printer.  When enabled, the printer will activate the RTS signal whenever the printer’s input 
buffer becomes nearly empty or when the printer’s control panel Setup Menus are active.  The RTS signal will 
be deasserted whenever the printer’s input buffer becomes nearly empty. 

Likewise, the printer will not send data to the host system if the host has asserted the CTS signal. 

 

 

Bluetooth Interface 

The following Bluetooth Interface menu features are only available and/or only take affect when the Bluetooth 
Interface is currently selected as the active interface.  For information on how to select the active interface, 
please refer to Control Panel Setup on page 25.   

 Note: Factory default values are indicated by an asterisk (*). 

 

Emulation 

Possible Values:  Printek*, O’Neil, ZPL-II, Mt3, CPCL 

This feature sets the family of printer commands that may be used by a host application program to control the 
various capabilities of the printer.  The printer will only respond to commands valid for the currently selected 
emulation.  For more information, please refer to the MtP Series & FieldPro Programmer’s Manual. 

 

Pairing Mode 

Possible Values:  Paired*, Unpaired 

This feature allows Bluetooth pairing to occur between the printer and the connecting device whenever Security 
is required by either device.  Pairing requires that the PIN on the printer and the connecting device exactly 
match each other. 

 

Role Policy 

Possible Values:  Defer*, Master 

This feature selects the role of the printer’s interface in the Bluetooth network.   

If the device attempting to communicate with the printer is having trouble discovering the printer, setting the 
value to Master may correct the problem. 
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Printer Configuration 

Discoverability 

Possible Values:  Off, On* 

This feature is used to set whether the printer may be discovered by other Bluetooth devices.  It should only be 
set to “Off” after the printer has been discovered and paired with a host computer. 

 

PIN 

Possible Values:  0*, Up to 16 Numeric Characters. 

Note that this feature is only available if Paring Mode is set to Paired.  The PIN value must exactly match the 
PIN value set on the host computer. 

 

Security 

Possible Values:  Off*, On 

Setting Security to On forces the printer and the remote device to use pairing.  Setting Security On requires that 
Pairing is set to Paired and that a PIN has been entered that matches the PIN in the remote device. 

 

Local Name 

Possible Values: FP-aaannnnn*,  
  Up to 16 characters of “0” through “9”, “A” through “Z”, “a” through “z”, “-“, “_”, SPACE 

This feature sets the name that will be displayed by most host systems when “discovering” the printer.  When 
shipped from the factory, the default value for the Bluetooth Local Name is “FP-aaannnnn” where “aaannnnn” 
is the printer’s serial number.  This name may be changed to any combination of letters, numbers, dashes, 
underscores, and SPACEs.  The name may be up to 16 characters in length. 

 

 

Wi-Fi Interface 
The following Wi-Fi Interface Menu features are only available and/or only take affect when the Wi-Fi 
Interface is currently selected as the active interface.  For information on how to select the active interface, 
please refer to Control Panel Setup on page 25.   

 Note: Factory default values are indicated by an asterisk (*). 

 

Emulation 

Possible Values:  Printek*, O’Neil, ZPL-II, Mt3, CPCL 

This feature sets the family of printer commands that may be used by a host application program to control the 
various capabilities of the printer.  The printer will only respond to commands valid for the currently selected 
emulation.  For more information, please refer to the MtP Series & FieldPro Programmer’s Manual. 
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Printer Configuration 

WLAN Type 

Possible Values:  Infrastructure*, Peer-to-Peer 

This feature specifies the type of wireless network the printer will be attached to.  An Infrastructure network 
consists of nodes that connect to each other and/or a wired network through an Access Point.  A Peer-to-Peer , 
or Ad-Hoc, network consists of nodes that connect directly to each other without the control of an access point. 

 Note: When using Control Panel Setup to change the WLAN Type to Peer-to-Peer, the following features 
will also be changed.  To change these features back to their original settings will require the use of 
the Printek Mobile Setup Utility. 
 

 IP Address Assign will be set to “Static” 
 IP Address will be set to “192.168.0.2” 
 WLAN Channel will be set to “1” 
 WLAN WEP will be set to “Disabled” 

 

WLAN Channel 

Possible Values:  1* … 14 

Note that this feature is only available if the WLAN Type is set to Peer-to-Peer. 

This feature sets the radio channel to be used when communicating in a Peer-to-Peer network.  When in an 
Infrastructure network, the radio channel is automatically assigned by the interface and Access Point. 

 

WLAN SSID 

Possible Values: any*, 
  Up to 16 characters of “0” through “9”, “A” through “Z”, “a” through “z”, 

This feature specifies the “name” of the network the printer will connect to.  This allows communications to be 
controlled, or routed to the appropriate nodes when multiple wireless networks are present.  When set to “any”, 
the printer may connect to any available network(s). 

 

WLAN WEP Bits 

Possible Values:  0*, 64, 128 

This feature specifies the level of Wired Equivalent Security to use.  If set to “0”, security is turned off.  If set to 
a“64” or “128” bit encryption level, a WEP Key must be entered that matches the key on the other nodes on the 
network. 

 

WEP Key 1, WEP Key 2, WEP Key 3, WEP Key 4 

Possible Values:  10 or 26 character user specified hexadecimal string 

Note that this feature is only available if WLAN WEP Bits is set to 64 or 128. 

This feature specifies an encryption “key” or password that is used to encrypt/decrypt data on the network.  If 
WLAN WEP Bits is set to “64”, a ten character hexadecimal string must be entered that matches the key on the 
other nodes the printer will be communicating with.  If WLAN WEP Bits is set to “128”, a 26 character 
hexadecimal string must be entered. 
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Printer Configuration 

WLAN Auth 

Possible Values:  Auto*, Open, Shared 

This feature specifies the authentication method that will be used when establishing connections on the network.  
The method may be to use an open key or a shared key.  If set to “Auto”, the printer will automatically match 
itself to the method used by other nodes. 

 

IP Address Assign 

Possible Values:  DHCP*, Static 

This features specifies whether the printer will obtain an IP address from a DHCP server, or if a an IP address 
will be manually assigned. 

 

IP Address 

Possible Values:  0.0.0.0*, User specified 

This feature specifies the IP address for the printer. 

Note that this feature has no effect if IP Address Method is not set to “Static”. 

 

IP Subnet Mask 

Possible Values:  0.0.0.0*, User specified 

This feature specifies the range of addresses, or the size of the network, that the printer’s IP address belongs to. 

Note that this feature has no effect if IP Address Method is not set to “Static”. 

 

IP Gateway 

Possible Values:  0.0.0.0*, User specified 

This feature specifies the network node where data destined for a node outside of the LAN should be directed. 

Note that this feature has no effect if IP Address Method is not set to “Static”. 

 

Tunnel Port Number 

Possible Values:  00000 … 08023* … 65384 

This feature specifies the TCP/IP port to be used for data that is to be printed.. 
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Printer Configuration 

Format Menu 

 

The features contained in the Format Menu affect the location and appearance of the data printed.   

 Note: Factory default values are indicated by an asterisk (*). 

 

Font 

Possible Values: 4.2 cpi SnsSrfA 16.9 cpi SnsSrfA 
5.5 cpi SnsSrfA 16.9 cpi Courier* 
10.2 cpi SnsSrfA 18.5 cpi SnsSrfA 
10.7 cpi SnsSrfA 18.5 cpi Courier 
12.7 cpi Courier 20.3 cpi SnsSrfA 
13.5 cpi Courier 20.3 cpi Courier 
14.5 cpi Courier 22.6 cpi Courier 
15.6 cpi Courier 25.4 cpi Courier 
 34.0 cpi SnsSrfA 
 
Any downloaded fonts will also be displayed. 

This feature selects the default font and character pitch. 

 

Spacing 

Possible Values:  0 … 3* … 10 Lines 

When printing text, this feature sets spacing between lines.  The height of a complete line, or line pitch, is 
determined by adding the vertical size of the current font to the Spacing.  With Spacing set to the default value 
of “3” and using a font that is 23 rows high, the line pitch would be 3 + 23, or 26 dot rows.  Since each dot row 
is 0.125mm, 26 x 0.125 yields a line pitch of 3.25mm. or 7.8 lines per inch  This line pitch value also 
determines the amount of paper motion performed when an ASCII Line Feed character is received by the 
printer. 

When printing graphic data, Spacing has no affect so that multiple lines of graphics may print adjacent to each 
other. 

Left Margin 

Possible Values:  0.0000”* … 1.0244” in increments of 0.0394” 

This feature sets the left margin in inches relative to the leftmost printing position.  (The leftmost print position 
is determined by the Left Paper Guide position as described in the Options Menu on page 23.)  The left margin 
must be less than the right margin.   

 

Right Margin 

Possible Values:  0.0000”* … 1.2608” in increments of 0.0394” 

This feature sets the right margin in inches relative to the rightmost printing position.  (The rightmost print 
position is determined by the Right Paper Guide position as described in the Options Menu on page 23. 

Text characters and graphic data that would have printed to the right of the margin will be truncated. 

 Note: The FieldPro RT43 has a maximum print width of 4.1”.  However, when Mt3 Emulation has been 
selected, the Right Margin will begin indenting from a maximum print width of 2.84” to match the 
characteristics of the Printek Mt3 Series printers.  

21 



Printer Configuration 

Print Contrast 

Possible Values:  -35% … 0* … +35% in increments of 5% 

The printer automatically adjusts the amount of energy used in order to maintain constant print quality as the 
battery discharges during use.  The Print Contrast setting modifies the value that is determined to be needed by 
the printer and may be used to obtain improved print quality on different qualities of thermal print media.  A 
higher value will result in a darker image. 

 Note: By affecting the relative amount of battery energy that is used when printing, the Print Contrast 
setting affects both print speed and battery life.  Setting a lower value will result in faster printing 
and will extend normal battery life.  Setting a higher value may allow the use of poorer quality media 
and will result in slower printing and a shorter battery life. 

 

Maximum Paper Speed 

Possible Values: 0.32, 1.36, 1.92, 2.35, 2.72, 2.81* ips 

This feature may be used to reduce the maximum paper speed if necessary to allow the printer to use heavier 
papers, narrow paper, or some coated papers that have a more slippery finish.   

 

FFeed Distance 

Possible Values: 0.0000 … 1.2608* … 2.5216 inches, or Mark Sensing 

This feature sets the distance that paper is to be moved whenever the user presses the Paper Feed Button or a 
Form Feed character is received from a host system.   

 Note: If Mark Sensing is selected, the paper will be advanced to the next Black Mark.  When Mark Sensing 
is used, the values of the Mark Sensitivity, Tearbar Adjust, and Top of Form Adjust features are 
available for adjustment. 

 

Mark Sensitivity 

Possible Values:  -10 … 0* … +10 

This feature allows the Black Mark/Paper sensor to be adjusted to allow for variations in media materials and 
Black Mark printing methods.  The following list will help determine if, and how, the Mark Sensitivity should 
be adjusted. 

• If the printer is not detecting black marks reliably, set the Mark Sensitivity to a lower value. 
• If the printer is detecting false Check Paper conditions, set the Mark Sensitivity to a higher value. 
• If the printer is detecting black marks where none exist, set the Mark Sensitivity to a higher value. 

 

Tearbar Adjust 

Possible Values:  -0.295” …0.000”* …0.315” 

This feature is used to adjust the tear position when black mark sensing is used. 

 

Top of Form Adjust 

Possible Values:  -0.295” … 0.000” … 0.295” 

This feature is used to adjust the location of the top line of printing when black mark sensing is used. 
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Printer Configuration 

Print All Logos In Memory 

 

This menu item is only available using Control Panel Setup and is only available if downloaded fonts and/or 
logos are currently stored in the printer’s memory.  Selecting this item causes the printer to print out a directory 
of all fonts and logos, and to print a copy of all logos. 

 

 

 

 

Options Menu 

 

The Options Menu contains features that affect the overall operation of the printer.   

 Note: Factory default values are indicated by an asterisk (*). 

 

Left Paper Guide Adjust 

Possible Values:  A*, B through G 

This feature is used to match the leftmost print position with the location of the Left Paper Guide.  For a 
complete description, please refer to the Right Paper Guide, below. 

 

Right Paper Guide Adjust 

Possible Values:  None*, 1 through 9 

Similar to the Left Paper Guide, this feature is used to match the rightmost print position with the right edge of 
the paper. 

The positions of the paper guides are used to adapt the FieldPro RT43 to be used with different widths of paper.  
To provide maximum flexibility for various paper widths and black mark positions, any combination of left and 
right guide positions may be used.  Paper widths less than 2.9” are not recommended. 

For instance, to use the standard four inch paper (4.125”), the Left Paper Guide would be located at position 
“A” as shown in Figure 12, below, and the Right Paper Guide would not be installed (None).  To use standard 
three inch paper (3.125”) the Left Paper Guide would be installed at “A” and the Right Paper Guide would be 
installed at position “7”.   

To remove a paper guide, simply pull the guide out of the printer’s paper compartment.  To install a paper 
guide, insert the end toward the rear of the printer first as shown in Figure 12 and then “snap” in the end toward 
the front of the printer.  When selecting guide positions, select positions that are as close to the end of the paper 
roll as possible, but not so tight that the paper cannot unroll easily. 

 

23 



Printer Configuration 

 

 
Figure 12 - Paper Guides 

Insert This 
End First 

Snap In This 
End Second

 

 

Auto Power Down 

Possible Values:  Off*, 1 Minute Delay … 15 Minute Delay 

This feature sets whether the printer will automatically power down and if so, after what period of time of 
inactivity.  If set to a value other that “Off”, the printer will automatically turn itself off after the specified 
number of minutes have passed since the printer last received data or last printed, whichever is longer. 

 

Print Promo 

Possible Values:  No*, Yes 

When set to “Yes” this feature causes a previously stored graphic image with an ID value of “$” to be printed at 
the end of each print job.   

This feature may be used to print a special logo or graphic image of a special sales promotion or other event. 

Please refer to the MtP Series & FieldPro Programmer’s Manual for more information on storing graphics and 
logos. 

 

Print Header 

Possible Values:  No*, Yes 

When set to “Yes” this feature causes a previously stored graphic image with an ID value of “?” to be printed at 
the beginning of each print job.   

Please refer to the MtP Series & FieldPro Programmer’s Manual for more information on storing graphics and 
logos. 
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Printer Configuration 

Hardware Menu 

 
Features in the Hardware Menu are used for software development/debugging and/or printer configuration.  
These features should not be changed unless directed by Technical Support personnel.   

 Note: Factory default values are indicated by an asterisk (*). 

 

Enter Hex Dump Mode 

Possible Values:  No*, Yes 

This feature is used to assist software programmers in determining the actual data values being received by the 
printer.  In this mode, printer commands are not processed, but are printed along with their hexadecimal value.  
For more information, please refer to the MtP Series & FieldPro Programmer’s Manual. 

 

Burnin Mode 

Possible Values:  Off*, On 

This feature is for factory use only.  Do not change this value. 

 

Reset to Factory Defaults 

Possible Value:  Hold Power 10 Sec. 

When this feature is displayed, holding the Power Button will cause all setup features in all menus to return to 
their factory default values.  Do not use this feature unless instructed by Printek Technical Support. 

 

 

 

Control Panel Setup 

 

Control Panel Setup allows the user to configure some features of the FieldPro RT43.  Other features may be 
configured using the Printek Mobile Setup Utility.  For a complete list of features and which method may be 
used to configure them, please refer to the Setup Menu Summary on page 13. 

Control Panel Setup makes use of the control panel Power and Paper Feed buttons and printing to step through 
the menus of features and values that may be changed.  Install plain receipt paper for this task. 

Entering Setup 

To enter Setup, press and hold the Paper Feed Button while turning on the printer with the Power Button.  The 
printer will print a test page which shows most of the menu features and their current values.  At the end of the 
test page, “PRESS FEED FOR SETUP MENU” will be printed.  Pressing the Paper Feed within the next four 
seconds will cause the Setup mode to be entered.  If the button is not pressed within four seconds, the printer 
will return to normal operation. 
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Printer Configuration 

Using Setup 
After the Setup mode is entered, instructions will be printed indicating that the Power Button may be used as a 
“Select” button and that the Paper Feed Button may be used as a “Next Menu” button. 

As instructed, press the Power to select each menu or item, and press the Paper Feed to skip to the next menu or 
item.  Upon selecting an Item inside a Menu and pressing Power, the displayed setting will change.  

Press Paper Feed to skip to the next item in the menu.  When EXIT MENU is displayed, press Power to go to 
the next menu. 

When in a menu, you may press and hold Paper Feed until it beeps to skip to the next menu. 

You may press and hold the Power Button until the printer beeps once to set an item to its default value. 

The Interface Menu is the first menu of features displayed.  If an optional Bluetooth or Wi-Fi Interface is 
installed in the printer, the first option presented will be to switch to the interface that is not currently the active 
interface.  This feature will typically only be used when needing to switch from the optional interface to Serial 
so that the Printek Mobile Setup Utility can be used.  After completing any changes with the setup utility, this 
same process may be used to switch back to the previously selected interface. 

Exiting Setup 
To save the changes you have made, press Power when the EXIT SETUP SAVE CHANGES Menu selection 
appears. 

To exit without saving changes, press Power when the EXIT SETUP DISCARD CHANGES Menu selection 
appears, or at any time you may press and hold the Power Button until the printer beeps and turns off.   
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Interfacing To A Host Computer 

Every FieldPro printer is equipped with a Universal Port which contains a Serial Interface.  The Serial Interface 
may be used for either RS-232C or USB communications depending upon which optional cable is used.  
Optional factory installed interfaces are also available for Bluetooth® and Wi-Fi®.  When the printer is equipped 
with one of the optional interfaces, only one of the interfaces may be “active” at any time.  For information on 
switching the active interface, please refer to Control Panel Setup on page 25 of the Printer Configuration 
section of this manual. 

 Note: To print out configuration information for the currently selected interface, you may press and hold 
the Paper Feed Button while turning the printer on. 

 

 

 

Serial Interface 

The Serial Interface contained in the Universal Port may be used for either an RS-232C or a USB connection.  
For either of these connections, the Serial Interface must be the currently active interface.  If there is no optional 
interface installed, Serial will be the only interface available.   

When using the Serial Interface for RS-232C communications, the baud rate, data bits, parity, stop bit(s), and 
handshaking method (XON/XOFF, ETX/ACK, RTS/CTS) must be set to match the settings on the host 
computer.  If these settings do not match, errors and/or lost data may occur.   

When using the Serial Interface for USB communications, the printer’s default values of 57,600 Baud, 8 Data 
Bits, 1 Stop Bit, No Parity, and RTS/CTS = Yes must be used. 

To access the Universal Port connector, refer to Figure 13 and move the lever in the direction shown to unlock 
and remove the cover.   

 

 

 
Lever 

Cover 

Figure 13 - Removing The Universal Port Cover 
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Interfacing to a Host Computer 

Figure 14 and Figure 15 show the location of the Universal Port Connector and the connector pin assignments. 

 Caution: Do not make any connection to pins 4 or 8.  These pins are used only for Printek accessories and 
improper connections with these contacts may cause severe damage to the printer.  Such damage will 
not be covered by the printer’s warranty. 

 

 
Connector

Figure 14 - Universal Port Connector 

 

 
Pin # Signal Description                           

1 COM Logic Common 
2 TXD Transmit Data (From Printer) 
3 RXD Receive Data (From Host) 
4 Reserved Do Not Connect 
5 CTS Clear To Send (From Printer) 
6 COM Logic Common 
7 RTS Request To Send (From Host) 
8 Reserved Do Not Connect 

Figure 15 - Connector Pin Assignments 

 

 

 

 

Bluetooth® Interface 

In addition to the standard Serial Interface, your FieldPro RT43 may be equipped with an optional Bluetooth 
Interface.  Bluetooth interfaces are built into some Smartphones and  PDA’s and may be added to most others.  
Bluetooth interfaces may also be added to notebook or desktop computers.  To communicate using the 
Bluetooth Interface, it must be selected as the currently active interface. 

The Bluetooth Interface uses wireless, radio frequency signals to communicate. 

The FieldPro Bluetooth Interface acts as a “serial port adapter” operating as a “server”.  Being a serial port 
adapter means that the printer may appear as a “Serial Device” when discovered, rather than as a “Printer”.  
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Interfacing to a Host Computer 

Operating as a server, other devices such as a PDA or other host computer may initiate the connection to the 
printer.   

When discovered, the default name that will appear will be “FP-aaannnnn” where “aaannnnn” is the printer’s 
serial number.  To obtain the printer’s Bluetooth name, you may print the printer’s test page by holding the 
Paper Feed button while turning the printer on.  For pairing, the default PIN value is “0” (if this value does not 
work, contact your system administrator). 

To conserve battery power, application programs should disconnect from the printer whenever possible. 

 

 

 

 

Wi-Fi® Interface 

In addition to the standard Serial Interface, your FieldPro RT43 may be equipped with an optional Wi-Fi 
Interface.  Wi-Fi interfaces are built into some PDA’s and may be added to most others.  Wi-Fi interfaces may 
also be added to notebook or desktop computers and as an “access point” to a wired network.  To communicate 
using the Wi-Fi Interface, it must be selected as the currently active interface. 

The Wi-Fi interface uses wireless, radio frequency signals to communicate. 

The FieldPro Wi-Fi interface acts as a server and will accept connections from a host device such as a PDA, 
notebook computer, or a network server. 

The FieldPro Wi-Fi interface conforms to the IEEE 802.11b standard.  The factory default settings for this 
interface are: 

 WLAN Type: Infrastructure 
 WLAN SSID: any 
 WLAN WEP Bits: 0 (Off) 
 WLAN Auth: Auto 
 IP Address Assign: DHCP (The DHCP name will be “FP-aaannnnn”  
   where “aaannnnn” is the printer’s serial number.) 
 Tunnel Port: 8023 
 

These settings for the Wi-Fi interface features may be modified as described in the Printer Configuration section 
of this manual on page 13. 

To print out the current Wi-Fi configuration details, you may print the printer’s test page by holding the Paper 
Feed button while turning the printer on.  Enter Control Panel Setup and use the “Print Interface Settings” 
feature to obtain the current IP address when assigning addresses via DHCP.  When doing so, be sure to wait 
several seconds after turning the printer on to allow it to establish a connection with the network and be served 
an address. 

When operating in Infrastructure mode, the printer will attempt to conserve battery power whenever possible by 
placing the Wi-Fi interface into a low power mode when not communicating.  However, according to the IEEE 
802.11b standard, the printer must be granted “permission” from the network’s Access Point before operating in 
the low power mode.  Since different Access Point manufacturers implement this feature differently, the amount 
of power saving actually achieved varies.  The actual power saving also varies with the amount of network 
traffic. 
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Power Considerations 

FieldPro printers are designed to provide superior output using as little power as necessary.  This provides the 
longest possible battery life.  The printers may also be operated from an external power supply when used in a 
more permanent installation in a vehicle or office.  The following discussions indicate how the printer 
accomplishes this power conservation using features such as Standby and Auto Power Down.  For more 
information on battery charging, please refer to “Charging the Battery” on page 34. 

 

 

Standby Operation 

When operating on battery power, the printer automatically enters a Standby mode one minute after the last 
computing event (i.e., receiving data, printing, a front panel button is pressed, or a magnetic card reader swipe 
operation).  When in Standby, the printer will flash the Power Indicator. 

While in Standby the printer turns off as many power consuming components as possible.  However, the printer 
remains fully capable of receiving data or responding to a control panel button.  The printer will automatically 
“wake up” when it begins to receive data from a host system, or when any front panel Button is pressed. 

 

 

Auto Power Down 

To conserve even more battery power, the printer may also be configured to turn itself off after a specified 
number of minutes of inactivity.  When the printer powers down, this is equivalent to turning the printer off 
using the Power Button and the printer will no longer respond to incoming data. 

To enable the Auto Power Down feature, please refer to the Options Menu settings on page 23. 

 

 

Operation Without A Battery 

FieldPro printers may be operated with an optional power supply and without a battery installed.  Power 
supplies are available for use with 100-240VAC/50-60Hz and for 12/24VDC vehicle applications.   

 Caution: Use only Printek power supplies designed specifically for your FieldPro RT43 printer.  Using a 
different power supply may cause damage to the printer and will not be covered by the printer’s 
warranty. 
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Maintenance and Troubleshooting 

Cleaning 
In normal environments, the printer should be cleaned after printing a few rolls of paper or if there are voids in 
the printout.  For optimum performance and life, you should clean the Print Head and Platen Roller whenever 
you load new paper.   

To clean the printer areas as described below, use a Thermal Head Cleaning Pen and MCR Cleaning Card 
available from Printek, or you may use cotton swabs moistened with isopropyl alcohol.  Please refer to Figure 
16 for the following instructions. 

 

 

MCR Slot 

Print Head 

Black Mark 
Sensor 

Platen Roller Tear Bar

Figure 16 - Printer Cleaning Areas 

• Turn the printer off.  Open the Paper Door and remove the paper. 
• Using a Thermal Head Cleaning Pen, clean the surface indicated on the Print Head. 

Caution: Do not use sharp objects to clean the print head.  This may damage the printer and require 
service.  Such damage is not covered under warranty. 

• Clean the Black Mark Sensor below the print head. 
• Clean the Tear Bar 
• Clean the Platen Roller.  Turn the platen roller with your finger to clean the entire surface. 
• If a Magnetic Card Reader is installed, pass an MCR Cleaning Card through the MCR slot to clean the 

head. 

You may also experience a build up of paper dust in the printer.  This may be removed  using a can of 
compressed air or by vacuuming. 

To clean the exterior of the printer, turn the printer off and use a soft cloth moistened with a mild detergent. 
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Maintenance and Troubleshooting 

Battery Care 

Charging the Battery 
The printer’s battery is charged in the printer using an optional power supply.  Power supplies are available for 
100-240VAC/50-60Hz and for 12/24VDC vehicle applications.  Follow the steps listed below to charge the 
battery.   

• Plug the power supply into a power source appropriate for the adapter being used. 

• Plug the power supply into the power connector on the side of the printer.  The printer’s battery 
charging circuitry will analyze the condition of the battery and begin charging it if necessary. 

• If the battery is not fully charged, charging will begin and the Battery Indicator will illuminate. 

• When the battery is fully charged, the Battery Indicator will turn off.  Charging may take up to 2½ 
hours depending on the condition of the battery. 

• The printer may be used while the battery is charging, but this will extend the time required to fully 
charge the battery. 

• The power supply may remain connected to the printer to keep the battery fully charged and will not 
cause damage to the printer or battery. 

 

Additional Battery and Safety Information 

• All FieldPro series printers us a 7.4 volt 2200mAH Lithium Ion battery. 

• The recommended ambient temperature for charging is 68-77° Fahrenheit (20-25° Centigrade). 

• Take the battery out of the printer when storing the printer for long periods of time.  The battery 
storage temperature is 40-104° Fahrenheit (4-40° Centigrade).  Do not store a fully charged battery at 
temperatures above this range for long periods of time or the battery may permanently lose charge 
capacity. 

• Do not disassemble, short circuit, heat above 80°C, or incinerate the battery. The battery may explode. 

• Only dispose of used batteries according to your local regulations.  If you do not know 
your local regulations, the Rechargeable Battery Recycling Corporation (RBRC) is a 
non-profit organization created to promote recycling of rechargeable batteries.  For more 
information visit www.rbrc.org. 
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Maintenance and Troubleshooting 

Testing the Power Supply and Battery 
To verify that the printer’s internal battery charger is functioning properly, perform the following steps. 

• Test the power adapter (100-240VAC/50-60Hz, 12/24VDC adapter) with a voltmeter to verify that its 
output voltage is 9 VDC. 

• Connect the power supply to a power source and then connect it to the printer. 

• Verify that the printer’s Battery Indicator is illuminated.  If illuminated, the charging circuit is 
functioning properly.   

Note:  that if the battery is already fully charged, the Battery Indicator will turn off after a short 
time. 

• After the battery has been charged for five minutes, disconnect the power supply. 

• Perform a printer Self-Test. 

o Make sure the printer is turned off.   

o Press and hold the Paper Feed Button while turning the printer on. 

• If the printer successfully prints the Self-Test, the battery is functional.  If the Self-Test does not 
complete and the printer turns itself off, repeat this test with a known good battery. 

• Once this test has completed successfully, allow the battery to fully charge.  At the end of this time the 
Battery Indicator will turn off.   

If the printer and battery do not appear to successfully pass these tests, refer to the Troubleshooting section for 
possible causes and solutions. 

Note: This test only verifies that the power adapter, the internal charging circuit, and the battery are 
functioning properly.  This test does not provide a valid indication of the relative capacity of the battery 
or how long it may hold a charge.  
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Maintenance and Troubleshooting 

Troubleshooting 
When encountering problems, the cause may be the printer or may sometimes be due to other problems with 
your system.  Please review the following tables to solve common problems you may encounter with your 
printer.  You may also visit www.printek.com for additional “FAQ’s” that may assist you.  

If you are still unable to solve your problem, please contact the company where you purchased your printer 
since they are most familiar with your systems.  If they are unable to help you, you may contact Printek 
Technical Support at (800) 368-4636. 

Error Conditions 

Whenever the printer detects an error condition. the Error Indicator will either flash or stay on.  In some cases 
the audible alarm will also sound.  Please refer to the following table for a list of what causes these conditions 
and how they may be corrected. 

 
Error Indicator Possible Cause Solution 
Flashes, With Alarm Paper Out Install paper and press the Paper 

Feed Button to clear the error. 
Stays On, No Alarm  Paper door not fully closed. Make sure the door is fully closed 

by opening the door and closing it 
again until the door “clicks” 
closed.  Check the platen roller for 
damage. 

Stays On, With Alarm Communications error. Verify communications settings in 
the Interface Menu.  Printer must 
be turned off to clear error. 

 
 

Other Problems 

Problem Possible Cause Solution 
Battery not installed properly. Remove and reinstall battery 

making sure the battery release 
lever “clicks” when fully installed. 

Printer will not turn on. 

Discharged battery. Recharge battery. 
Auto Power Down is enabled. Change setting in Options Menu as 

described on page 23. 
Battery discharged. Replace or recharge battery. 

Printer turns itself off. 

Electrostatic discharge. May occur in extreme low 
humidity conditions.  Turn printer 
back on with power button. 

Battery already fully charged. No action required. 
Power supply not receiving power. Check building/vehicle circuit 

breakers/fuses. 
Faulty power supply. Check output of power supply with 

voltmeter.  9 VDC. 

Battery Indicator does not light or 
does not stay lit when power 
supply is connected. 

Battery not installed properly. Remove and reinstall battery 
making sure the battery release 
lever “clicks” when fully installed. 
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Maintenance and Troubleshooting 

Problem Possible Cause Solution 
Battery not charging. Faulty power supply or battery. Refer to “Testing the Power 

Supply and Battery” on page 35. 
Low battery. Check and recharge battery. 
Print head dirty. Clean print head.  Refer to page 33.

Poor print quality. 

Poor quality or “old” paper. Verify paper from approved 
source.  Try new roll of paper. 

Obstruction in paper path or paper 
improperly installed. 

Check paper path and reinstall 
paper. 

Poor quality paper. Verify paper from approved 
source. 

Paper not feeding. 

Paper Door not fully closed. Verify door is closed. 
Poor quality paper. Verify paper from approved 

source. 
Heavy or thick forms. 
Specialty paper with slick finish. 

Lower the Max Paper Speed as 
described in Format Menu on page 
21. 

Paper not feeding reliably or print 
is compressed vertically 

Paper Door not fully closed. Verify door is closed. 
Low Battery. Check and recharge battery. 
Improper Serial Interface 
configuration. 

Verify printer and host settings 
match.   

Print Garbled. 

Paper Door not fully closed. Verify door is closed. 
Low Battery. Check and recharge battery. 
Paper not loaded correctly. Check paper path and reinstall 

paper. 

Printer will not print. 

Improper interface configuration. Verify printer and host settings 
match.  Print a self test to verify 
printer settings and to verify printer 
is functioning properly. 

Cannot print via optional interface. Interface not configured correctly. Print a self test to verify printer 
settings.  Make sure the interface is 
selected and make sure printer and 
host set ups match. 

 

 

 

Obtaining Service 

If service is required for your printer, please contact the company where you purchased your printer.  If they are 
unable to assist you, contact Printek Customer Service at (800) 368-4636 to obtain the name of the nearest 
Printek Authorized Service Center. 

If you wish to return your printer to Printek for service, please contact Printek Customer Service at (800) 368-
4636 to obtain a Return Authorization Number.  Units returned without a Return Authorization will not be 
accepted. 
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Print & Font Samples 

Print Samples 
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Print & Font Samples 

Courier Font With International Extended Character Set 

  
 

 

 

Courier Font PC Line Drawing Extended Character Set 
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Print & Font Samples 

Sans Serif Font 
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Specifications 

Printer Specifications 

Printing Specifications 

 Printing Method: Direct Thermal, Up To 2.8 Inches Per Second 
 Printing Resolution: 203 dots per inch (8 dots per mm) 
 Printing Width: 832 Printing Elements for up to 4.1″ (10.41 cm) 

Fonts/Characters/Bar codes 

 Fonts: A wide range of font types and sizes, from ~ 6 cpi to 34 cpi plus scaling depending 
on emulation chosen 

 International Characters: Arab-T, Arab-S, Arab-E, Asian fonts and an expanding catalog available for 
download 

 Bar Codes: Code 39, Code 128, UCC/EAN-128, UPC/EAN/JAN, Interleaved 2 of 5, 
CODABAR, EAN08 & 13, PDF-417, UPC 

 Downloads: Downloadable fonts, graphics, logos, and additional bar codes 

Connectivity 

 Serial: RS-232C (Standard), USB (Optional cable required) 
 Wireless: Bluetooth, Wi-Fi 801.11b (Options) 
 Universal Port: Data and power port allows connection of external devices such as Printek barcode 

scanners, signature capture pads 
 Emulations: Printek, Printek Mt3, O’Neil, ZPL-II, CPCL, Extech 
 Software Available: Drivers for Windows 98/2000/XP.   

Print Utilities for Palm OS.   
SDK’s for Palm OS.  
Setup utility for configuration from Windows 98/2000/XP. 

Data Input 

 Magnetic Card Reader: 3 Track, Simultaneous Read (Option) 

Power Management 

 Battery: 7.4 V, 2200mAH rechargeable 2 cell Lithium Ion 
 Endurance: 500 pages or more than 3,5000 inches of print per charge 
 Internal Charging: 2½ hours (requires optional power supply) 
 Battery Free Operation: Printer may be used with optional external power supply, with or without battery 
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Specifications 

Physical Specifications 

 Size: 6.1 x 5.9 x 2.7 inches, 15.5 x 15.0 x 6.9 cm (LxWxH) 
 Weight: 20 Ounces (.57 kg) with battery 

Environmental Specifications 

 Operating Temp: -4° to 122°F (-20° to 50°C) 
 Storage Temp: -4° to 140°F (-20° to 60°C) 
 Humidity: 10% to 90% RH (non-condensing) 
 Rating: IP54 per IEC 529, without optional environmental case 

Operator Controls and Indicators 

 Indicators: Power/Wireless Connection, Battery Status, Fault 
 Controls: Power, Paper Feed 
 Sensors: Paper, Paper Door Open, Black Mark Detection 

Memory Capacity 

 Flash: 1MB Program Memory; 1MB Font, Logo and Graphic Storage 
 RAM: 1MB 
 EEPROM: For Nonvolatile Configuration Storage 

Durability and Reliability 

 Drop Test: Survives multiple 4 foot drops to concrete (each face), conforms to IEC 68-2 
 MTBF: 10,000 hours in normal use 

Regulatory Approvals 

 Approvals/Markings: FCC Class B 
CE Mark 
RoHS 
WEEE 
UL listed AC adapters 
E-mark on In-Vehicle adapters 

Warranty 

 Printer: One year including print head and battery 
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Specifications 

Media Specifications 

Receipt Paper 

 General Specifications: 0.0022 to 0.0065” (0.056 to 0.089mm) Thick 
2.9 to 4.125” (73.66 to 104.78mm)Wide 
1.75” (44.45mm) Maximum Outside Diameter 
0.750” (19.05mm) Core Diameter Recommended 
Black Mark Sensing On Printed Side  

 
 Approved Vendors: Kansaki:  P300, P310, P350, P354, P390*, P530UV, TO281CA,  

               OP200, TO381N, F180, F380, F550 
  Jujo:  TF-50KS-E2C 
  Honshu:  FH65BV-3 
  Appleton:  Resiste 900-3.0* 
     *Standard Printek Offering 
 

Black Mark Position 

For automatic ticket printing, the black mark should be positioned as shown in the figure below.  When using 
Mark Sensing mode, FieldPro printers will automatically position the output for tear-off and printing following 
a Form Feed command or by pressing the Paper Feed button.   

For non-automatic paper positioning, refer to the MtP Series & FieldPro Programmer’s Manual for sensing and 
positioning commands. 

 

0.15” 
Black Mark should span width 
of paper for best results. 

Perforation or tear position 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 17 - Black Mark Position 
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Specifications 

Supplies and Accessories 

Supplies 

 Battery: 7.4V, 2200 mAH Li-Ion 
Available separately or in 5 or 20 packs. 

 Media: 3.125” and 4.125” wide standard receipt paper 
3.125” and 4.125” wide premium receipt paper 

  Available in cases of 36.  Other sizes available on request. 
 Cleaning Supplies: Print head cleaning pens 

Magnetic Card Reader cleaning cards 
 
 
 

Accessories 

 Power Supplies: 100-240VAC/50-60Hz Wall Adapter 
12/24VDC Vehicle Adapter 

 Carrying Options: Shoulder Strap 
 Cables:  RS-232C – RJ to DB-9F 

 USB – RJ to USB-A 
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Glossary of Terms 

802.11 Wireless networking communication standards created by IEEE. 

access point An interface between a wireless network and a wired network. 

Ad-Hoc A Wi-Fi network consisting of only stations (no access point).  Same as Peer-
to-Peer. 

ASCII American Standard Code for Information Interchange. 

authentication The process a Wi-Fi station uses to identify itself to another station.   

bandwidth The amount of data that be transferred in a given period of time. 

baud rate The rate at which characters are transmitted over a serial interface.  This is also 
often referred to as bits per second. 

binary Base two numbering system.  Digits are represented by the characters 0 and 1.

bit A single binary digit. 

Bluetooth A definition for short range radio frequency communications. 

client Any node on a network that requests services from another node (server). 

control code A single, non-printing character which is used to control the configuration or 
operation of the printer. 

character pitch The horizontal spacing of characters.  Measured in cpi. 

cpi Characters per inch. 

current line The line upon which the next character will be printed. 

current print position The column on the current line where the next character will be printed. 

default Value or configuration assumed when the printer is powered on or reset. 

DHCP Dynamic Host Configuration Protocol.  A method used to centrally control the 
assignment of IP addresses on a network. 

dpi Dots per inch.  Generally used to refer to graphics density or resolution. 

escape sequence String of characters beginning with the escape (ESC) character which is used 
to control the configuration or operation of the printer.  The characters which 
are part of this string are not printed. 

font A group of characters of a given shape or style. 

hexadecimal Base sixteen numbering system.  Digits are represented by the characters 0 
through 9 and a through f. 

IEEE Institute of Electrical and Electronic Engineers 

infrastructure A Wi-Fi network consisting of stations connecting to a wired network or other 
stations via an access point. 

interface The connection between the printer and the host computer. 
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Glossary 

IP Internet Protocol.  A specification for packets, or datagrams, of data and an 
addressing method to allow the exchange of data with another system.  Must be 
combined with another protocol such as TCP to create a complete connection 
with the other system. 

LAN Local Area Network. 

LCD Liquid crystal display.   

LED Light emitting diode. 

line pitch The vertical spacing of rows of characters.  Measured in lpi. 

lpi Lines per inch. 

margin An area along any edge of a form where data may not be printed. 

MSB Most significant bit.  In a character, this refers to bit seven (of 0 to 7). 

node Any device connected to a network. 

parity A method used for detecting errors within a single character transmitted or 
received via an interface. 

Peer-to-Peer A network consisting of only stations (no access point or central server).  Same 
as Ad-Hoc. 

reset Initialization of various operating features of the printer to the value or state 
assumed when the printer is powered on. 

RS-232C An EIA standard for serial data transmission. 

server Any node on a network that provides services to another node (client). 

SSID Service Set IDentifier.  An identifier attached to packets on a Wi-Fi network 
that identify the particular network the packets are intended for. 

TCP Transmission Control Protocol.  A specification that controls the connection 
between systems on a network. 

top of form The vertical position where the first line is printed on the paper.  Also the 
position the paper is advanced to when a form feed (FF) character is received 
from the host or the Form Feed button is pressed on the printer's control panel.

USB Universal Serial Bus. 

WAN Wide Area Network.  Refers to connections that allow one LAN to 
communicate with another LAN(s). 

WEP Wired Equivalent Privacy.  A security protocol for wireless LANs designed to 
provide data security similar to a wired LAN. 

Wi-Fi Refers to any of the IEEE 802.11 standards. 

WLAN Wireless Local Area Network.  A LAN made up of wireless nodes. 
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